VIZCREATOR PRESENTATION

BRINGING NUMBERS TO LIFE

L6.1

View this pdf page-by-page with your "left" and "right" arrow keys versus with your "up" and "down" arrow keys.

This best simulates the scenario sequences and animated transitions.
Visualization Creator
03/30/06
Overview

In order to clearly communicate the interaction of various elements within the Visualization Creator (VC), we have described several scenarios in which the VC would be used.

We believe the users of the VC range from Ling to Sven. However, different users will have different entry points and uses for the VC. Ling will do no analysis, but simply define data. John/Sven will analyze data and publish it in order to communicate a specific point.
Scope: Chart types

The chart families for the scope of this phase of the Visualization Creator are Bar, Line, Pie, Plot and Gauge. Within each family, there are several types. The types within scope are those listed above.

NOT in scope are: Area, Radar, Polar, Finance, Stock, Histogram, Box, Map, Vector, Hierarchical, Network, Fish-Eye.
Scope: Style elements

The Visualization Creator provides a means to edit most stylistic elements of a theme.

However, editing some types of stylistic element provides little or no true value to the user, and provide a means to negatively affect the legibility of data.

The design deliberately avoids providing capability to edit:

Axis line widths
Axis color
Label and header type size
Individual element colors on the fly (this is controlled by a theme palette, meaning any change is global to that theme).

This will also have the added effect of creating a specific Business Objects visual style to the charts, while also allowing for a level of personalization.
Overview of screen areas/ Panels

Scenarios
- Scenario 1
- Scenario 2
- Scenario 3

Other Functions
- Changing Chart Type
- Re-stacking Dimensions

References
- Axis Guides
- Refresh Data button
- Recommendations Panel
- Theme Editor
- Selection Model
- Preview mode
- 2 Axis Layouts

Slide Controls
- Back to previous slide
- Back to Start
- Exit slideshow
Visualization Creator

Left Pane

Data Tab: Allows user to explore data. This will house an instance of the Repository Explorer (transversal UI).

Templates Tab: Allows user to browse visualization templates they have created or those shipped with Visualization Creator.

Properties Tab: Provides configuration options for visualization elements.

Canvas Area: This is the area in which the visualization will appear and be manipulated.

Main Window: Contains the entire Visualization Creator interface.

Preview button: The user can preview the completed visualization and drill down in preview mode.

Refresh Data button: When clicked, the real values of the data set being used are cached to the front end.

Recommendations Panel: This piece is not finalized. See slide 8 for options.

Toolbar: Provides basic controls.

Preview button: The user can preview the completed visualization and drill down in preview mode.

Refresh Data button: When clicked, the real values of the data set being used are cached to the front end.
Toolbar

Save button: Allows user to save the visualization to a specific location; embed it in an existing report; export as image file (JPEG, TIF, BMP etc).

Theme menu: Allows user to set/change/create themes used in the visualization.

Add Annotation: The user can add a note to the visualization.

Back/Forward buttons: These allow user to undo/redo changes made to the visualization.

Graph Type Menu: Allows user to set/change graph type used in the visualization.

Data Table:
   a) Clicking this button pops open a simple data-table. This either displays the selected data, or allows users to manually key in values to create a chart from scratch.
   b) clicking this button takes the user to webi/olapi data table.

Left pane button: The user can show/hide the left pane to maximize canvas area.
Recommendations panel options

- Splitting the existing left-pane into two parts, each with tabs.
- Narrow column on right side of screen or could be floating palette.
- Existing panel on right side could be converted to floating window.

Tab on bottom of screen. Changes to show current best recommended chart, clicking on it will provide a list of all suggestions.
Left pane: Data Tab

Source Menu:
The source menu allows the user to see contents of a universe, or of an existing report.

Source List:
When showing a universe, data elements are listed and can be dragged in to create a chart. The representation of this state is unfinished, as this is an instance of a transversal UI (Repository Explorer).

Source Menu:
The user can select a report, or default to a report by doing a ‘turn to’.

Source List:
When showing a report, the list contains only data elements within that report.

Controls:
All On/Off selects either all or none. If the data selection cannot be applied to the chart immediately, an ‘Apply’ button will be necessary.
Left pane: Template Tab (Placeholder)

Source Menu:
The source menu allows the user to see Templates within a specific location. Could include My Templates, Corporate Templates, etc.

Source List:
Templates can be opened from the list. Opening a template will close any currently open document.

A template could contain any combination of:
- Chart Type
- Theme
- Data
- Properties configuration

* The definition of a Template has yet to be defined. This tab is currently on hold.

Preview:
Preview shows a small preview of the file, containing text positions, chart type, theme type.

It also lists the data elements contained in the chart type.
Left pane: Properties tab

**Data Options:**
Allows setting of data-specific controls.

**Display Data as:**
- %: will normalize the data
- Value: will show real data values. 'Value' is default.

**Truncate Data:**
- Auto: Auto will truncate data automatically, optimizing the 'difference' in relevant discrepancy of values.
- Manual: provides the user a set of on-chart drag-able areas to manually optimize the data display.

**Highlight:**
- When a user wants to highlight a single bar, line or other chart component, they can choose to highlight it in one of two ways:
  - Series: Maintains all elements in series colors but depicts the highlighted bar in the highlight color set in their theme.
  - Monochrome: Depicts the highlighted element in the key color, all other elements in the secondary color in the range.

(See Theme and Selection model)

**Legend:**
User checks the box to display the legend.
Any choices made here override choices made in the theme, without affecting the theme.

**Display:**
- Allows setting of chart-specific controls.
- The checkboxes for 'Title' through 'Annotations' allow show/hide for those elements.

**Grid Lines:**
Turns on/off grid lines in the chart background.
Scenario 1: Turn to

FedEx Jack needs to produce a visualization of a sales report that John, a business manager at FedEx Corp. needs to see.
Jack opens the OLAP report 'Sales Volume'
<table>
<thead>
<tr>
<th></th>
<th>FedExGround</th>
<th>FedEx Express</th>
<th>FedEx Freight</th>
<th>FedEx Home Delivery</th>
<th>FedEx Kinkos</th>
</tr>
</thead>
<tbody>
<tr>
<td>2004</td>
<td>36805421</td>
<td>2736271</td>
<td>12726482</td>
<td>1776484</td>
<td>24982743</td>
</tr>
<tr>
<td>2005</td>
<td>46436372</td>
<td>3278239</td>
<td>12937464</td>
<td>1783637</td>
<td>16938462</td>
</tr>
</tbody>
</table>

On right-click, Jack selects the 'Turn to Chart' option 'Next to this table' (wording needs to be finalized).
Visualization Creator opens, in edit mode. Jack sees the layout guides. Title and Legend are automatically populated. Alternative chart styles are offered by the Recommendations panel.
Notes on Turn to: Restricting complex data sets

When activating a ‘Turn to’ from any BO Application, complex data sets must be restricted in order to create a visualization.

**Turn to menu:**
When selecting ‘Turn to’, the user has several options.

- Next to this table: Supplements the existing table with a chart. Once the visualization has been created, saving it will place it next to this table.
- Replacing this table: The finished visualization will replace the original data table.
- In new report: The user will be prompted to name the new report. The finished visualization will be placed in the new report.
Notes on Turn to: Restricting complex data sets

When activating a ‘Turn to’ from any BO Application, complex data sets must be restricted in order to create a visualization.

**Dialogue box:**
If working with a very complex data set in the table, having selected ‘turn to’ on a complex data set, the user sees a dialogue box telling them that the Data set will be restricted, but they can change the selection in the Data tab of the left pane.

**Source Menu:**
The source menu will now reflect the report name. Switching to another report name will display a dialogue asking the user to either save this visualization back into the originating report, discard it, or cancel the operation. If the user chooses to discard or save the report, the screen will then refresh with the newly selected report and appropriate visualization.

**Source List:**
When a user does a ‘Turn to’ from a complex data table, the Visualization Creator will select the first x members of each type of data, until a conflict is met, at which point no further members of that type of data will be used in the initial visualization displayed.
FedEx Ling builds a report from measures, knowing her chart type.
From within any BO application, Ling opens viz creator...
She sees a blank chart area of no specific layout type.

The recommendations panel shows various starting points.

FedEx
She goes to the Chart Type menu...
...and selects a Bar and Line chart.
She now sees Layout Axis guides appropriate for a Bar and Line chart. The recommendations panel does not begin to display alternative chart options until data elements are added.

The chart title is "FedEx."
She drags in the measure 'Escalations'. The right Y-axis indicates that dropping the measure will place it in this location.
She sees the current value for the measure Escalations.

The Recommendations Panel offers further options to more clearly display the currently added data elements.
She sees the current value for the measure Escalations.
She sees the current value for the measure Escalations.
She now drags in the measure ‘Incoming Hot Fixes’. It is plotted along the Y-axis.
Incoming Hot Fixes, Escalations
Last 12 Months

'Incoming Hot Fixes' is plotted along the Y-axis.
She now drags in the measure "Released Hot Fixes". A new 'Measure' indicator appears on the left y-axis.
Incoming Hot Fixes, Escalations
Last 12 Months

All measures are now shown in series.
Scenario 3: From Data

FedEx Joanne builds a report from measures, without knowing what her chart type will be.
From within any BO application, Joanne goes to the ‘Insert’ menu and selects ‘New Chart’.
She sees a blank chart area of no specific layout type.

The recommendations panel shows various starting points.
She drags in the measure 'IncomingHotFixes'.

The layout guides reflect where the data element will be placed.

If no chart type is selected, the Visualization creator will default to a bar chart (until the data defined would be better displayed by another graph type).
She now sees the measure plotted as a single bar. The bar represents the current actual value of the measure ‘IncomingHotFixes’.
She drags in the measure 'ReleasedHotFixes'...
Both measures are now represented at their actual current value.
She drags in the measure 'Escalations'...
All three measures are now represented at their actual current value.
She drags in the Time Dimension ‘Months’...
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months

All three measures are now represented at their actual current value, and last 12 months.

Chart type in the menu changes to a Grouped Bar.
Scenario 3: From Data (cont)

There are three methods by which Joanne can create a Bar and Line chart from here. She can:

- Change Graph Type
- Restack the data elements manually
- Use the Recommendations panel
Other Functions

Scenarios
- Scenario 1
- Scenario 2
- Scenario 3

Other Functions
- Changing Chart Type
- Re-stacking Dimensions

References
- Axis Guides
- Refresh Data button
- Recommendations Panel
- Theme Editor
- Selection Model
- Preview mode
- 2 Axis Layouts

Slide Controls
- Back to previous slide
- Back to Start
- Exit slideshow
Change Chart Type

With too few required elements
With too many elements
Change Graph Type

With too few required elements
With too many elements
Joanne has a line chart. She wishes to change this to a Bar and Line chart.
She clicks on the graph type menu...
...and changes type to Bar and Line.
The first measure dragged in to a bar and line chart becomes the right axis. A new measure axis guide is seen on the right hand side, encouraging Joanne to place another measure. The next measure added will create the bars.
Change Graph Type

With too few required elements

*With too many elements*
Change Graph Type

Too Many Elements:

There is only one instance in which changing graph type will require the user to remove an element. This is if the user changes from a Bubble Chart to a Scatter chart.

All other chart types are cross-compatible.

Removing an element
Not removing an element
Joanna has a Bubble Chart. She wishes to make this a Scatter Chart.
She clicks on the Graph Type menu...
...and changes type to Scatter.

Revenue/Profit by Region

Region 1
Region 2
Region 3
Region 4
Discount

FedEx

...and changes type to Scatter.
A dialogue box pops up explaining that the last measure added will be removed. Joanne clicks ‘OK’.
Joanne has a Scatter chart.
Change Graph Type

Too Many Elements:

There is only one instance in which changing graph type will require the user to remove an element. This is if the user changes from a Bubble Chart to a Scatter chart.

All other chart types are cross-compatible.

Removing an element
Not removing an element
Joanne wants to reorder her bar chart so that Escalations is shown as a line.
She goes to the Chart type menu...
Incoming Hot Fixes, Released Hot Fixes, Escalations

...and changes chart type to Bar and Line.
Incoming Hot Fixes, Escalations
Last 12 Months

The chart type changes to Bar and Line, and the measure added first becomes the line.
Restack Dimensions

When restack does not change graph type
When restack changes graph type
Joanne wants to reorder her bar chart so that Escalations is the first measure in the series, not the last.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months

She clicks on the measure ‘Escalations’...
She now drags the measure to the desired location.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months
Incoming Hot Fixes, Released Hot Fixes, Escalations

Last 12 months

FedEx
On dropping the measure in the new location, the chart is reordered.
Restack Dimensions

When restack does not change graph type
When restack changes graph type

Scenario
- Scenario 1
- Scenario 2
- Scenario 3

Other Functions
- Changing Chart Type
- Re-stacking Dimensions

References
- Axis Guides
- Refresh Data button
- Recommendations Panel
- Theme Editor
- Selection Model
- Preview mode
- 2 Axis Layouts

Slide Controls
- Back to previous slide
- Back to Start
- Exit slideshow
Joanne clicks on the measure 'Escalations'…
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months

FedEx

...and drags it to the far right of the chart area.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months
A new drop zone appears, indicating that she can drop the measure here. If she dragged the measure to a location where no drop zone appears, dropping the measure will result in the measure remaining in its prior location.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 Months

On dropping the measure, the chart becomes a Bar and Line.
Reference

Scenarios
- Scenario 1
- Scenario 2
- Scenario 3

Other Functions
- Changing Chart Type
- Re-stacking Dimensions

References
- Axis Guides
- Refresh Data button
- Recommendations Panel
- Theme Editor
- Selection Model
- Preview mode
- 2 Axis Layouts

Slide Controls
- Back to previous slide
- Back to Start
- Exit slideshow
Axis guides

Axis guides are used to imply the orientation and placement of data elements. There are three types of data element:

- Measure
- Dimension
- Time

Within certain layout types, some data elements are ‘required’, others are optional. Required elements are indicated by a red asterisk:
Axis guides 2

When a user drags a data element to a drop zone, the active drop zone is highlighted:

![Dimension *](image)

When a data element is placed within an axis guide, the measure name is shown and the axis guide is seen as ‘filled’. Any ‘required’ asterisk is removed, and replaced by a ‘close’ button.

![Region X](image)
Refresh Data button

In the instance that live data can not be rendered within Visualization Creator, the user will see obvious sample data.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 Months

Clicking on 'Refresh Data' will load the real data.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 Months

FedEx
The recommendations panel is designed to assist the user in making the most appropriate choice of chart for the data they are displaying.

It offers appropriate alternative chart types, ranked by order of appropriateness.

It could also house Michael Thompson’s ‘Smart Viz’ component (not shown).
Joanne has built a series bar chart, but wants to represent Escalations differently from both HotFix measures.

The Recommendations Panel ranks a Bar and Line chart as the best choice for the given data.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 months

Joanne clicks on the Bar and Line chart...
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 Months

...and the Bar and Line chart is applied to the existing data.
Theme Editor

Themes are a concept which allows the user to manage every aspect of the visual appearance of a chart.
The theme menu contains previously defined themes, and provides the ability to edit themes.

There could be personal themes and corporate themes. Personal themes are those only this user sees and can edit; corporate themes are those that every user sees and only some are permissioned to edit.

Jack clicks on ‘Edit Themes’.
The Theme editing window opens. Three tabs contain all editing features.

The Preview area below allows the user to see how each type of chart will appear.

Foreground tab contains Skin, Color Palette and Font.

He clicks the 'New' button...
Jack names the theme 'FedEx Corporate' and clicks 'Save'.
Clicking on each color in the series allows Jack to change that color via a color picker.
In the background tab, Jack can select from a series of ‘mini themes’. Each is designed to optimize legibility between the background, axis lines, and line and text values.

Jack can also specify to include a background image or watermark, by selecting an image file to include.

He places the FedEx logo as a background image.
In the Layout tab, Jack can specify Title position, Legend position, Default display elements and content of a tooltip to be displayed on rollover of a bar, line or other chart element.
Using the same process, he can build themes for FedEx Ground, FedEx Express, FedEx Freight, FedEx Home Delivery and FedEx Kinkos.
Selection Model

On click, individual data points can be selected.

Individual bars on a bar chart

Individual data points on a line on a line chart

Individual slices of a pie chart

This enables highlighting in the properties panel. The user can then highlight a specific piece of data.

Demonstrated in file: VizCreationScenarios2.ppt (slide 30)
Preview mode vs. Edit mode

In Edit mode, all edit capability is available.

Under the selection model, when in Edit mode, clicking on a bar will select it (see Selection Model).

In Preview mode, all edit capability is removed, and the selection model is changed. Clicking on a bar will drill down.
Incoming Hot Fixes, Released Hot Fixes, Escalations

Last 12 Months

FedEx

In Edit mode, all edit capability is available.

Under the selection model, when in Edit mode, clicking on a bar will select it (see Selection Model).
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 Months

FedEx

Preview pops open a window displaying the interactive chart.

In Preview mode, all edit capability is removed, and the selection model is changed. Clicking on a bar will drill down.
An instance was identified where our proposed method of handling a Bar and Line chart was insufficient. We had placed bars on one axis, line on another. However, this affects the users ability to create multi-axis charts.

Here we propose a method whereby, in a multi-type chart such as bar and line, the user can specify the chart type of each data element.

This provides the ability to switch which element defines lines and which defines bars along a single axis.
Incoming Hot Fixes, Released Hot Fixes, Escalations
Last 12 Months

All measures are aligned on a single Y axis, and each measure has a 'chart as' button above it. Clicking on this button will display options contained within the multi-type chart.

In this instance, the only options available are Bar or Line. The user should not be provided capability to display anything other than one of the options defined by the multi-type chart.